“Exploring a Satellite Image”

MultiSpec© Freeware Tutorial

(Windows PC Version: Feb2008)

Installing MultiSpec on Your PC:

e Turn on you computer.
e Start Windows (if not already running)

Download the appropriate MultiSpec software for your computer (or copy the files from
CD) onto your computer’s hard drive. The download site is:
http://cobweb.ecn.purdue.edu/~biehl/MultiSpec/

e Note: If you download the files, you must unzip the files before they can be used. If you
do not have the software to do this, let us know.

e If you download the software, keep track where the files are downloaded so that you can
find the MultiSpec folder easily. The MultiSpec program file (MultiSpec.exe) will be in
that folder and you can create a shortcut to that from your desktop. This is done by
clicking on the right mouse button and choosing “Create Shortcut”. Then drag the new
icon to your desktop.

Step 1: Create a folder with your name on your computers desktop
to save downloaded materials in.

Step 2: Download “MultiSpec” software from the MultiSpec website

http://cobweb.ecn.purdue.edu/~biehl/MultiSpec/

Step 3: Download the Beverly Massachusetts L.andsat image from the
UNH Globe website
http://www.globe.unh.edu

Follow the links
1. MultiSpec Materials
2. Electronic Mapping

Download the following image.
Bevsub.lan (Beverly.lan when downloaded)

Note: If problems arise with the Windows setup or the MultiSpec program will not start,
send email to forestwatch@unh.edu or support@mvh.sr.unh.edu with
subject line MULTISPEC for further guidance and troubleshooting.
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Materials needed:
PC with ‘Beverly.lan’ image installed

Getting Started:

e After turning on your computer, start Windows.

e Double click on the MultiSpec icon to start the MultiSpec program. MltiSpecw32.exe

e The window labeled Text Output should appear. Your screen should be similar to the
one shown in the diagram below.

MultiSpec Wlndﬁws .ﬁpplicatmn Txt~ [lﬁ)ut

e Pull down the File menu and select Open Image. Browse to, and Double click on
Beverly.lan to select that Landsat satellite image




e You should now have a dialogue box entitled Set Display
Specifications for: 'Beverly.lan’ displayed on your screen.

Set Display S}Eseciﬁcé(ioﬁs

In the top of the window is a box titled Area to Display. This box shows us that the image of
entire image of Beverly Massachusetts that we have to work with is selected and is 512
pixels by 512pixels square or approximately five square kilometers. We will return to this
coordinate system later on in the tutorial as well as alternatives.

e Click on the box labeled Display Type and be sure 3-Channel Color is selected.
e Leave all other the settings as they are or correct them to match above if different.

e Under Channels set Red box to 3, Green box to 2, Blue box to 1 and click OK. To edit
the number appearing by each color, click to the left of the number and, without releasing
the mouse button, drag the mouse to the right or double-click on the box. This should
highlight the number you want to change. When it is highlighted, release the mouse
button. The box should stay highlighted. Now type the number you wish to enter in the
box. You may use the Tab key to move between boxes on the screen.




Click OK. The image display should now appear in the upper left of your screen. At
x.500 magnification you can see the entire image at once.

Mulhﬁpeis atio

Hedian Standard

Deviation
0 to 255 83.7 62 46 .8
0 to 255 77 .86 67 431
0 to 255 60.1 43 51.4
0 to 255 98.1 95 86.5
0 to 255 82.3 100 73.6

nage. 02-18-2008 12:55:42

8 12:59:24 (HultiSpecWin32_5.12.2007)

mage. 02-18-2008 12:59:24

To enlarge the window, click on the lower right corner (a striped triangle) of the image
window and drag the box to the right and down. The window can be made as large as
your whole screen. In the lower right hand corner of the application window, is a box
that shows Zoom=X .500. This box depicts the current magnification factor being used to
display the image.




Identifying features in the image:

Try to identify highways, bridges, cities, lakes, forests, beaches, marshy regions near the
shore, shallow ocean waters, deep ocean waters, clouds and shadows, gravel pits, islands,
tidal areas, etc.

See Page 36 for Answers.

Zooming:

e The right three boxes in the toolbar, located directly above the image window, control the
magnification factor. The box shown as X1., when clicked on, will always return the
factor to 1. Click on this box now. The box in the lower right hand corner of the
application window should now read Zoom = X 1.0 and the image should enlarge and fill
the viewing window depending on how much you enlarged the image window.

e Notice the images that look like mountains in the tool bar to the right of the X1. box on
the toolbar. Use large mountains to zoom in with and small mountains to zoom out with.
These zoom boxes allow you to zoom in and out from the current image scale. (From
now on the large mountain box will be abbreviated as i and the small mountain box as o0.)
The box in the lower right hand comer of the application window (hereafter referred to as
the zoom box) will change every time the i or o box is clicked on the toolbar.
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Click the i once. Now click on i many, many times. You should eventually see the image
appear as a mosaic of squares (pixels) on the screen. Before proceeding to #2, click on the
X1. Box.

The image should now be full size and the zoom box should read X 1.O.

Questions:

a. What do you notice about the length of objects when you zoom in? when you zoom out?
Objects increase/decrease in ieiigih proportionately with the zoom factor.

b. What information is gained "vhen you zoom in or out? What information is lost?

When you zoom in, you can focus on a smaller region. Eventually the image becomes
a mosaic o pixeis. When you zoom ou., you can see a larger region at once.

Zoom Box:

You also can zoom in on a specific region by boxing the region and zooming. Place
the mouse pointer at the upper left corner of the area you wish to box. Then click and
hold the mouse buttesi while moving the mouse to the right and down. When you
have boxed off the desired area, release the mouse button. Notice that the region you
selected is delineated by dashed lines. Click on the i box. You can continue to zoom
in on the selected region by continuing to click on i. What do you observe? If the
zoom box is not square, do the image proportions appear to change? Give reasons for
your answer.

The proportions of a figure do not change. Lengths all change
proportionately. Shape stays the same, size changes.

To zoom in or out by tenths, hold down the Ctrl key while clicking on the i or o box.

Return to the full image by clicking on the X1. box so the zoom box reads Zoom=X
1.O.

Panning:
In order to move (pan) around the image, you can use the scroll bars at the right and bottom

of your screen. If your mouse has a center wheel between the right and left click buttons you
may use this or scrolling up and down.
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Investigating color in a satellite image

Image Display:
Under the Processor menu select Display Image

Please read the following information about color and Landsat satellite images. The colors
red, green, and blue refer to the computer monitor color guns. (They apply red, green and
blue light to each pixel in specific intensities.) The channels (often called bands) refer to
bands of reflected light sensed by the satellite from the objects in the image.

e Band 1 is reflected blue light,
e Band 2 is reflected green light
o Band 3 is reflected red light.

Red, green, and blue are the primary colors of visible energy. Different hues (shades)
of color are obtained on the screen when color guns apply different intensities of red,
green, and blue light to the same pixel. For example, equal intensities of red and
green light produce yellow; equal intensities of blue and green light produce cyan;
and equal intensities of blue and red light produce magenta. Bands 4 and 5 receive
reflected near infrared and mid infrared energy, respectively.

We will use the following red, green, and blue (RGB) channel settings in order to get
a feel for different channel (band) combinations.

True color images - This band combination presents an image as it would appear to the
human eye, looking back from space.

Red 3 (the visible red band)
Green 2 (the visible green band)
Blue 1 (the visible blue band)

Other band combinations result in images that do not appear as they would to the human eye.
These images are called false color images. To observe in the infrared which the human eye
cannot see we must apply a color to the infrared portion of the spectrum in order to see it.
Enter the following band combinations and observe the results.
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A. The band combination below mimics infrared aerial photographs. Plant material, which
reflects a great deal of infrared energy, will stand out as bright red with this band
combination. This is useful to people studying forests.

Red 4 (the near Infrared band)
Green 3 (the visible red band)
Blue 2 (the visible green band)

B. This band combination is especially good for separating trees and grassland. The conifer
or evergreen trees appear as intense dark green, deciduous trees appear as medium green,
and grassland appears as light green or yellowish green.

Red 5 (the mid Infrared band)
Green 4 (the near Infrared band)
Blue 2 (the visible green band)

Use the computer image of Beverly.lan for the following activity.

Locate the features in the chart below using each of the Red, Green, Blue (RGB) channel
settings listed. Record the color of each feature under each channel (band) combination. RGB
321 means assign Channel 3 to the red color gun, Channel 2 to the green color gun and
Channel 1 to the blue color gun.

To change the gun color assignments pull down the processor menu and select Display
Image or press Control + D

Trouble shooting hints:

If by mistake, you pull down the File menu and select open image, you will have to correct
ALL settings, instead of just the color assignments. To do this, go back to the GETTING
STARTED directions to be sure you do this correctly.

If you end up with a very tiny image it means you selected a small piece of the image by
mistake and asked to have it displayed. Under the Processor menu select Display Image.
Click on the small box in the upper left hand corner to the left of the words: Line and
Column. This will return the image to the full 512 by 512 pixel display.
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Complete the chart, recording the color of each feature under each channel (band)
combination.

RGB RGB RGB
321 432 542

- Beaches

- Highways

- Regions with trees
- Ocean

- Cities or towns

Try other channel (or band) combinations and write your observations.
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Reference Page
MultiSpec Bands and Their Uses

Band

Principal applications

1 Blue visible

Useful for mapping water near coasts,
differentiating between soil and plants, and
identifying human made objects such as roads
and buildings (cultural features).

2 Green visible light

Useful for differentiating between types of
plants, determining the health of plants, and
identifying cultural features.

3 Red visible

Useful in differentiating between plant species
Differentiation and identifying cultural
features.

4. Near Infrared energy

Most useful for determining plant types and
plant health, for seeing the boundaries of
bodies of water, and discrimination of soil
moisture

5. Mid-infrared energy

Useful for distinguishing snow from clouds
and Determining vegetation and soil moisture
content.

6. Thermal-infrared energy

(Separate downloadable image) Useful in
determining relative temperature and
determining the amount of soil moisture.

7. Mid-infrared energy (longer wavelength than
band 5)

(Not featured in this image) Useful for
differentiating between mineral and rock
types and telling how much moisture plants
are retaining.

Reference: Lillesand, Thomas M. & Kiefer, Ralph W. (1987), Remote Sensing and Image
Interpreration. 2nd Edition. New York: John Wiley and Sons. P. 567.
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Color My World

Preparation Reading:

Previously you changed the colors on the computer image. When you change the colors,
objects may be distinguishable as different colors or become indistinguishable when they
blend with the color of other objects around them. The six channels on the images portrayed
by the computer imaging program MultiSpec contain data from one of five different bands
(six bands with Landsat 7) of the electromagnetic spectrum. For each of the bands, Landsat
senses reflected light or energy and assigns a reflectance number to represent the brightness
level.

Three of these bands are in the visible range: channel 1 is blue reflected light, channel 2 is
green reflected light, and channel 3 is red reflected light. Reflected red, green, and blue light
are all useful for distinguishing between human made objects, such as roads and buildings,
and natural features, such as rivers, lakes, and mountains.

The other channels, channels 4, 5, and 6 (actually Landsat band 7) are in the infrared range,
invisible to the human eye. Reflected infrared energy is useful if you wish to determine plant
types, determine plant health, distinguish between snow and clouds, or identify mineral and
rock types. When you selected different numbers for 3-channel color for Beverly.lan, you
asked the computer to display three bands of the electromagnetic spectrum.

You can also display an image in 1-channel color. Your image will then display brightness
levels of only one band of the electromagnetic spectrum, such as red visible light or near
infrared energy.

In this lesson you should try to become comfortable with categories of objects based on their
reflectance in the different bands of the electromagnetic spectrum. This will help you better
understand the Landsat imagery.

Materials you will need:

Two PC computers with MultiSpec installed and the Beverly.lan image on each.

This activity can also be accomplished on one computer by opening multiple copies of the
Beverly.lan image and sizing each image window appropriately to viewed side by side.

See: “Tips for working on a single computer” Page 18.

Each group will need to team with another group and use both computers. If you are
fortunate and have one computer available for each student or pair of students, you may want

to do this activity in a larger group using the three computers

If you are working alone with only one computer you can open multiple copies of the
Beverly.lan and set different display specifications for each image.
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e For those using one computer. Pull down the File menu and select Open Image. Double
click on Beverly.lan image to select that Landsat satellite image. You should now have
two separate images of Beverly MA open.

We will explore the connection between electromagnetic energy and the channels, which can
be selected in the Display Image option under Processor in the MultiSpec menu. You will
probably want to keep handy the "Reference Page: MultiSpec Bands and Their Uses".

e [If you are restarting your computer, follow the first few steps in Investigating a
Satellite Image to get to the dialogue box entitled Set Display Specifications for

Beverly.lan.

e Click on the box labeled Display type and select 1-Channel Grayscale

isplay Specifizatms foy: .

1-Channel Grayscale

. Now the directions change for the two computers or images.

-On one computer, type in 4 for the channel (next to the word 'Gray"). (Remember to
highlight the number to be changed and then type the new number. Backspacing or deleting
the old number first does not always work in this program.) Press Enter or click on OK.

The gray scale image you see represents the reflectance levels of one band of electromagnetic
energy.

‘What band 1s that?
Is it a visible band?
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- On the other computer, type in 3. Press Enter or click on OK.

What band of electromagnetic energy is transmitted through channel 3?
Is it a visible band?

- If you have a third computer, select another visible band to view, or if working on one
computer, open a third Beverly.lan image, and repeat the previous steps.

After the image is displayed, enlarge the viewing window to approximately twice the
size. Click on the X1. box in the toolbar to enlarge the image. Your monitor should look
similar to the image that follows.

MultiSpec Windows Application - beverly-ma.img (ch. 4]

beverly-ma.img [ch. 4]

Scroll to make sure the display on each computer shows the same region of the image.

Keep the three images on the screens of the respective computers, making sure everyone
can see all three screens or all three images. The images will be in shades of gray.

You will need to change the channels on the computers you are using to answer the

questions below. To do that, select the Display Image option under Processor in the
MultiSpec menu and just change the channel number.
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Tips for working on a single computer:
The image below shows four copies of the Beverly MA, image open on a single computer.

Each image is set to 1-Channel Grayscale and from left to right Channels 1,2,3 and 4 are
displayed.

Once four images are open you can carefully re-size the windows and into four equal
Panels utilizing the entire monitor display area. After re-sizing the images, set all four to a
similar zoom factor. In the image below this was done by selecting each open image and
clicking the large mountains 3-times for each image. Once the zoom factors are all equal, it
will take a little careful panning in order to set the same view area for each image similar to
the picture shown below.

MaltiSpec Windows Application - Beverlyrwaimg (ch. 17

Channel #1 Channel #2 Channel #3 Channel #4

Please read:

If an object has a high reflectance level for a particular band, it appears very bright (nearly
white). If it has a very low reflectance, it absorbs most of that band and appears very dark
(nearly black). For example if an object reflects more blue light than red light, it will appear
lighter in the image for which the selected channel is 1 for blue light than in the image for
which the selected channel is 3 for red light.
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Answer the following as completely as you can:

l.

You should be able to distinguish trees, the railroad bridge between Beverly and
Salem, and shallow bays more easily in one image display, but not in the other. Roads
are bright in one image and dark in the other. Explain these observations with
reference to the red and near-infrared bands of the electromagnetic spectrum.

Trees absorb red light and appear dark in the red band and can be distinguished from
beaches and grasslands. In the near-infrared band the trees appear very bright because they
reflect near-infrared energy. They are not easily distinguishable from the grassland.

The shallow water east of the Beverly-Salem bridge reflects a small level of visible red light
and appears lighter than the deeper ocean. Al1 water areas absorb near-infrared energy and
mid-infrared energy.

The railroad bridge reflects red light and is visible in the red band. It absorbs near-infrared
energy and is not easily distinguishable in the infrared band.

Highways reflect red visible light and absorb near infrared energy.

List other objects that have either high reflectance of visible red light and low
reflectance of near infrared energy or high infrared and low visible red.

Buildings, often called cultural features because they are human made, reflect visible red
light but absorb near infrared energy.

Note: To answer the following questions you will have to change the bands on the
computers and make comparisons.

3.

Cultural features are human-made features such as roads, buildings, and bridges.
What do you notice about their reflectance of visible light and infrared energy? On
the computer that displays visible red light, change the channel to visible green (band
2) and then visible blue (band 1) to answer this question.

Cultural features have high reflectance of all visible light and low reflectance of near-
infrared energy.

What do you observe about the relative reflectance of a) red, b) blue, and c) green
light; and d) near-infrared energy by the ocean? For an extra project, you may want to
do some library research to determine why bodies of water appear blue when you
actually look at them.

Bodies of water absorb almost all energy, but blue visible light will reflect more than other
bands.
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10.

What do you observe about the relative reflectance of a) red, b) blue, and ¢) green
light, and d) near-infrared energy by trees?

Trees reflect low levels of red and blue visible light and slightly higher levels of visible green
light. They reflect high levels of near and mid infrared energy.

What do you observe about the relative reflectance of a) red, b) blue, and c) green
light; and d) near-infrared energy by "cultural features"?

Cultural features reflect all visible light and low levels of near-infrared energy.

There is a cloud over Beverly and several other small clouds in the image. Try
various bands to make observations about the reflectance of clouds?

Clouds reflect all visible light and all infrared energy. This is why cloud free images are
important to distinguish surface features of the earth. Clouds "hide" the earth. Radar does
penetrate clouds. Landsat 6, which was not successfully launched, had a radar sensor.

Shadows of clouds and lakes appear dark in the image. Try various bands to develop
ways to distinguish cloud shadows from lakes.

Lakes reflect low levels of visible light and essentially no infrared energy. Shadows are
"transparent” and reflect whatever is beneath them. This means that if they are over
trees, the region in the shadow will reflect high levels of infrared energy

Write a question about color and images and either answer it yourself or have a
neighboring group try to answer it. Write the question and answer here.

Answers will vary.

The designer of the chart below did not finish her work. a. Insert the scale on the
"reflectance levels" axis. b. Insert the words that go with the numbers on the
"channel” axis. (See page 36 for answer)

Reflectance levels




11. Suppose you had selected a pixel that contained only trees. On the chart in #10, try to
predict a channel reflectance value for each band. Use your answer to question 5 for
help in answering this question (See page 36 for answer).

Graphing
Preparation Reading:

The histograms you will be studying are of the reflectance values at each of the 5
wavelengths the satellite measures. On the horizontal scale the numbers 1 through 5 refer
respectively to the blue, green, red, near-infrared, and mid-infrared wavelengths. The vertical
scale ranges from O (no reflectance) to 255 (maximum reflectance). Sometimes the vertical
scale will go beyond 255, but the values plotted never exceed 255. Note that the graph really
only has meaning when read at the horizontal positions of 1, 2, 3, 4, or 5. The line segments
that connect the points don't represent reflectance values of other wavelengths. They simply
make the graph easier to read.

The red line is the average of the reflectance of all the pixels in the selected area. The green
lines mark off all reflectance within 1 standard deviation of the average, and the blue
lines mark the minimum and maximum values. A formal definition of standard deviation
is not developed. You are simply instructed that the green lines contain about 66% of the
reflectance in the selected area.

Comparing Graphs between two separate images:

Mathematically the primary emphasis should be on the interpretation of graphs. You will be
viewing graphs that are automatically scaled to fill the window. While convenient, this
feature can be confusing as the vertical scale can change dramatically from one region to the
next. So although two graphs may look the same their vertical scales could be vastly
different. This phenomenon highlights the difference between two graphs having the same
relative shape but different absolute shapes.

For example, consider the two graphs below; while the relative shapes are about the same,
the absolute shapes are very different. The histogram on the left has a dip on band 4 as does
the histogram on the right; however, the dip on the histogram on the right is very small
compared to the one on the left! Note that the dip on the right actually looks larger than the
dip on the left. It is when we look carefully at the vertical scales, however, that we discover
that the dip on the left is a change of almost 200 intensity values while the dip on the right is
of only 12 intensity values! The dips are in the same relative position on both graphs but of
very different absolute sizes.
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Comparing or displaying multiple graphs from the same image:

Varying scales will only cause interpretation problems when trying to compare graphs from
two separate images. When opening multiple graphs from the same image, scales will
automatically be re-scaled equally. The two graphs below display large differences in
reflectance, yet the scales are both set equally and this makes for easier visual comparison
between the two.

How can we classify and discriminate between regions on an image using histograms?

By now you should understand that the images we have been studying are based on numbers
that represent the intensity of reflected light at five different wavelengths. Stretching the
image and assigning various colors to different wavelengths helped us discriminate between
similar looking regions that were in fact different. But some regions still may appear similar
on the computer screen even though they represent different objects on earth. In this lesson
we learn how to use another tool of the MultiSpec program to help us classify regions, and
discriminate between different regions.
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Which of These Things Doesn't Belong?

At the computer, start the MultiSpec program and open the image of Beverly, MA, if it is not
already done. Assign the colors red, green, and blue to bands 3,2,1 to generate a true color

image.

Now from the View menu choose the Coordinates View. Now from the Window menu
select New Selection Graph. Click anywhere on the image window to highlight it, and click
again on any one pixel of the image.

By re-sizing the windows (lower right corner of a window) and moving the windows around
the desktop (drag the window by its title bar) arrange the windows so that they appear similar
to the figure that follows.

Mltpéﬁ V;fndows Application -Leverly-ma img chs. 3.2.1)

Coordinates Bar:

Directly above the image in the figure above is the Coordinates bar. This bar allows you to
know exactly what part of the image you are selecting when you click on the image window.
The coordinates of the cursor are given as an ordered pair with the line number given first
and the column number given second. In this figure the pixel selected is the one at (102,
135). Depending on the magnification factor you are using you may have to use the scroll
bars on the image window to find a particular pixel.



Selection Graph:

To the right of the Image window is the Selection Graph window. This is the window you
should learn to use during this computer session. It is a graph of the reflectance values of the
pixel (or pixels) you have selected. In the above figure the graph is for the pixel located at
(102,135).

This graph provides much information. The bottom axis has labels 1, 2, 3, 4, and 5 that
correspond to the blue, green, red, near-infrared, and mid-infrared wavelengths that Landsat
monitors. The vertical scale corresponds to the numerical value of the reflectance. This scale
can range from 0 to 255. A 0 would represent no reflected light and a 255 would represent
maximum reflected light. Remember that these values may be the result of stretching the
data. The pixel we have selected is brightest in bands 4, and darkest in band 3. This means
that the object at this location on the earth is reflecting more near-infrared light than light of
the other wavelengths.

Now click anywhere on the image window to activate it. Then click on the pixel with
coordinates (L,C) = (254,248) that is down on the ocean. At this point we find reflectance’s
of about 60, 44, 10, 11, and 6. See figure below for an idea of what your screen should
resemble.

o

MultiSpec Windows Application - Selection Graph

Lines-Columns

-
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Note that the reflectances are lower at every one of the five bands than for the previous pixel
at (102,135). This difference makes sense since we expect the ocean to be darker than
ground. If you have ever flown over ocean and trees you will have noticed how the ocean
appears almost black while the trees do appear brighter. The fact that water absorbs almost
all of the energy that falls on it can help us determine if an unknown dark region is water or
not.

Now select a rectangle of many pixels. We selected a rectangle with its upper left corner at
pixel (L,C) = (85,94) and its lower right corner at (L,C) = (129,138). Select these same pixels
by going to the Edit Selection Rectangle item under the Edit menu and typing in the
coordinates. The result should resemble the figure below.

ines-Columns

(HultiSpec3 .8

02 17:38:14

Note that now the selection graph contains 5 lines. The red line is the average of the
reflectance of all the pixels in the rectangle we selected. The green lines mark off a range
that contains the middle 66% of the reflectance values. The blue lines indicate where the
minimum and maximum values are for the reflectance of all the pixels we selected. For
example look at the reflectance on band 4. Of all the pixels selected in the rectangle the
lowest reflectance is about 10, the highest reflectance value is around 255, 66% of the
reflectance is between 130 and 208, and the average reflectance is about 160.
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Using the Histogram Window to Discriminate Between Different Regions

We can use the histogram window to help us identify similar and different regions. What we
will do is find an area of interest and save its histogram to compare with a second histogram
of another area of interest. Go to a magnification of x2.0. Again go to the Edit Selection
Rectangle item under the Edit menu and enter a rectangle with upper left corner (L,C) =
(179,30) and lower right corner (L,C) = (182,37). Your screen should resemble the figure
below.

-2002 17:38:01

14 {HultiSpec3.8.
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Now choose New Selection Graph from the Windows Menu. A new selection graph
appears and the old selection graph will remain fixed even if you select a new set of pixels.
Position the second selection graph below the first graph so that your display resembles the
figure below.

pec Windows Application

beverly-ma.img [chs. 3.2.1)

After your screen looks similar to the one in the figure above, click in the image window to
activate it, and then click on an image pixel. Note that the top graph stays the same and only
the bottom graph changes. Displaying both graphs allows us to compare the histogram of a
new region with the saved histogram of the white region visible in the image. This white
region is near a road and in the city limits of Beverly. It is very likely that this bright area is
caused by light reflecting off large buildings with metal or concrete roofs.
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What's That?!

Using the reflectance histogram tool, explore the Beverly, MA image and see if you can find
other examples of regions on the screen image that appear the same to your eyes but have
very different histograms. You can display up to 12 histograms on the screen at one time for
comparison of features.

Some possible explorations include:

Distinguishing beaches and shore, from very shallow water.

Differences between pavement on roads or parking lots and buildings.

Comparisons between shallow water and deep water.

Exploring similarly colored areas of vegetation that may have different histograms.

Examining in detail the transition from land to ocean. For example look at the histogram for
one pixel at a time beginning with (138,397) and moving east through pixels (138,398),
(138,399), (138,400), ...., (138,412).

If you find something interesting write a paragraph that provides a guide to exploring the
interesting feature you have found. The guide should be complete enough that someone else
can reproduce your explorations. Also include in the paragraph your analysis of the objects
you are examining. Support any conclusions you make with arguments based on the
histograms of the relevant objects. You can also copy histograms to the clipboard and paste
them into another application, such as a word processor, to form a library of representative
histograms of specific features. You can then investigate an unknown image and identify
features by finding similar histograms to those in the library.
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Finding the area of irregularly shaped regions

Forested regions and lakes generally have irregular boundaries. In this portion of the tutorial,
you will be asked to find the area of an irregularly shaped object.

Inscribed/Circumscribed Rectangle Method

In this method you overestimate the area of a region with one rectangle and underestimate
the area of a region with a smaller rectangle. Averaging the areas gives a quick estimate of
the area of the irregularly shaped region. For our example, we will find the area of an off-
shore island near Beverly, MA. In Figure 1, a rectangle defines a region with area larger than
that of the island.

ines-Columns

Figure 1.

To determine the coordinates of the selected region, under the View menu, select
Coordinates View. Note the Coordinates in the figure.

Consider the screen to be a large coordinate graph with (0,0) in the upper left comer, (512,0)
in the upper right hand comer, (0,512) in the lower left, and (512,512) in the lower right as
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shown in Figure 2. Lines are horizontal and can be thought of as rows in a matrix. Columns
are vertical and can be thought of as columns in a matrix.

Columns
100 200 300 400 500
(0,0) 0,512)
e ®
100
200
w2
2
= 300
—
400
500
°
20 (512.512)

Figure 2.

The coordinates in Figure 1 are lines 272 to 301 and columns 347 to 370. Since 301 - 272 =
29, the highlighted rectangle is 29 pixels in length (vertical) or 30 meters * 29 = 870 meters.
The difference of the columns is 370 - 347 = 23 pixels. Multiplying, 30 meters * 23 = 690
meters. The area of the highlighted rectangular region is 870 meters * 690 meters or 600,300
square meters.

Follow the same procedure to determine the area of the highlighted region in Figure 3 on the
next page.
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: “ Icatmn « beverly-ma.lm c-

beverlyp-ma.img {chs. 3.2.1)

Lines-Columns

igure 3.

(290-278) * 30 = 360 meters; (364 - 349) * 30 = 450 meters. The area is 360 meters *
450 meters = 162,000 square meters.

Use the information just computed to determine the area of the island.

(600,300 + 162,000)/2 = 381,150 square meters. Assuming one digit accuracy, the
area is approximately 400,000 square meters.

This concludes the basic portion of the MultiSpec tutorial. You should now be able to use
what you have learned here to investigate images of your own area. There are many other
capabilities of this software program that are addressed in the advanced portion of this
tutorial that will follow.



CREATING THE TMS/TM4 BAND

Below are directions for creating the TMS5/TM4 artificial band that will allow you to look for
stressed vegetation in your image.

1. From the File Menu select Open Image and then select the image you want the new band
created in (Beverly.lan).

2. From the Processor Menu select Reformat...

3. Select Change Image File Format.

Lines-Columns

4. The Set Image File Format Change Specifications window will appear. Click on the
Transform Data... box in the left edge center of the window.

Erdas 74 format
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5. The Set Reformat Transform Parameters window will appear. Click on
New Channel from General Algebraic Transformation circle.

Set Reformat Transform Parameters

6. Enter the formula for the transformation as shown and click on OK.

7. The Set Image File Format Change Specifications window will appear again. Click
on OK.

8. In Save As: window that now appears, enter C6 in the File Name: box and then click
on OK.

Save As.

‘33 ftipsubl.giz Tipjul
tipsub? bl @ troads. shp
iy MultiSpec_Description

@ MultiSpeciwiaz

README_Win32
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The new band will now be created and saved as C6. Only half the job is complete at this
point. We must now append this band to the old image and create a new image file with all

six bands.

9. With the original image still on the screen, open the File Menu and select Open Image. In
the Open window click on the Link to active image window box in the lower left corner.

Highlight C6 and click on Open.

MultiS peciw/ina2

| Ch @] Tipju
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When the window reappears click on Cancel. The filename at the top of the image window
will now read L.2image name.

L2-heverly-ma.img [chs. 4,3.2)

10. From the Processor Menu select Reformat...

11. Click on Change Image File Format.

12. The Set Image File Format Change Specifications window will appear. Click on OK.

13. In the window that now appears, enter any file name you want other than the current
image in the Save As: box and then click on Save.

The new file is now created with the TM5/TM4 band appended as band 6. ( 1- blue
visible, 2- green visible, 3- red visible, 4- near infrared, 5- mid infrared, and 6- TM5/TM4
ratio band) To depict stressed vegetation as red, display band 6 with the red color gun, band 4
with the green, and band 3 with the blue.
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Answers to Figure on page 9:

Forest

! Gravel Pit
Tidal Area

! Highway
Lake

Marsh
Cloud & Shadow
City

Island
Bridge
Shallow Bay
Deep Water
Beach

Answers to graph from page 20:

(High) (Bright)(100%) (255) A typical forested pixel representation.
A A A A
s
>
2
8
g
8
v v v v E
(Low) (Dark) (0%) (1)

| I I l l
All of the above are possible 1 2 3 4 5
scales for the y axis. Blue Green Red Near IR Mid IR
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